Microsoft® Office Word 2007 Inside Out

Katherine Murray and Mary Millhollon

To learn more about this book, visit Microsoft Learning at http://www.microsoft.com/MSPress/books/9801.aspx

9780735623309
Publication Date: May 2007
Table of Contents

About the CD ............................................................ xxiii
System Requirements .................................................. xxv
Conventions and Features Used in This Book ...................... xxvii
Introduction ............................................................. xxix


Chapter 1 Room to Create with Office Word 2007 .................. 3
A Quick Look Back: The Origins of Word ........................... 3
A Whole New Way of Working: Word 2007 Changes ................ 5
  What the Work World Needs Today ............................... 6
  Enter Word 2007 ...................................................... 6
Getting Familiar with the Word 2007 User Interface ............... 8
  Find What You Need, Intuitively .................................... 9
  Exploring the Ribbon ................................................ 10
  A Major Redesign for the File Menu ............................... 11
  Choose File Tasks Quickly with the Quick Access Toolbar ....... 12
  Using Dialog Launchers ............................................. 13
  Applying and Using Themes ......................................... 14
  Working with Galleries .............................................. 15
  Using Live Preview .................................................. 16
  Making Quick Formatting Changes with the Mini Toolbar ....... 17
  Viewing Documents in Different Lights ............................ 18
  Displaying Rulers and Gridlines ................................... 23
  Viewing More Than One Page at a Time ............................ 24
  Working with Multiple Documents .................................. 25
Understanding Status Bar Data and Tools ............................. 27
Controlling Word 2007 Options ........................................ 28
Setting Up the Microsoft Word Trust Center ......................... 30
Using Your Word Resources ........................................... 32
What’s Next? ......................................................... 33

What do you think of this book? We want to hear from you!

Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit:

www.microsoft.com/learning/booksurvey/
# Table of Contents

## Chapter 2

**Document Creation with Word 2007**  
- Creating and Working with Content in Word .......................................................... 36  
  - Creating New Documents from Templates ......................................................... 36  
  - Accessing Recently Opened Documents ........................................................ 39  
  - Inputting Data ....................................................................................................... 40  
- Performing Basic Editing Tasks ............................................................................. 41  
  - Selecting Text ....................................................................................................... 41  
  - Selecting Information with Your Mouse ............................................................. 42  
  - Selecting Text by Using Keyboard Commands .................................................... 43  
  - Copying, Cutting, and Pasting ............................................................................. 43  
  - Using the Office Clipboard .................................................................................... 46  
  - Undoing, Redoing, and Repeating ........................................................................ 47  
- Creating Theme-Enabled Documents ..................................................................... 49  
  - See Themes in Action ........................................................................................... 49  
- Opening Word 97-2003 Documents in Compatibility Mode ............................... 51  
- Converting Existing Word Documents to the Word 2007 File Format ............... 52  
- Running the Compatibility Checker ....................................................................... 53  
- Saving Documents .................................................................................................. 54  
  - Saving Changes to Existing Documents ............................................................... 54  
  - Saving Files by Using the Save As Dialog Box ..................................................... 55  
- Retrieving Local and Shared Documents .............................................................. 57  
- Taking Advantage of AutoRecover and Background Saves .................................. 58  
- Word 2007 and Microsoft Office 2007 Integration .............................................. 61  
  - Turn Word Documents into PowerPoint Presentations ....................................... 61  
  - Edit PowerPoint Notes or Handouts in Word ....................................................... 62  
  - Sharing Excel Data with Word ............................................................................. 62  
- What's Next? ........................................................................................................... 63

## Chapter 3

**Mastering Page Setup and Pagination** ................................................................. 65  
- Basic Page Setup Options ....................................................................................... 66  
- Changing Margins and Orientation ....................................................................... 66  
  - Changing Margin Settings .................................................................................... 67  
  - Choosing Orientation ............................................................................................ 69  
- Selecting Paper Size and Source .......................................................................... 69  
  - Choosing a Paper Size ......................................................................................... 69  
  - Selecting the Paper Source .................................................................................. 70  
- Saving Page Setup Defaults to the Current Template ........................................... 71  
- Controlling Page and Section Breaks ................................................................... 73  
  - Adding Manual Page Breaks ............................................................................... 74  
  - Creating Additional Sections ............................................................................. 75  
  - Inserting Text Wrapping Breaks ......................................................................... 77  
- Working with Varying Page Settings .................................................................... 78  
  - Multiple Page Settings ....................................................................................... 80  
  - Aligning Content Vertically Between Margins .................................................... 81  
  - Creating a Page or Section Border ...................................................................... 82  
- Including Headers and Footers ............................................................................. 82  
  - Adding Page Numbers ......................................................................................... 82
Chapter 4

Formatting Documents Using Templates ................................................. 95

Nature of Document Formatting Tools .................................................. 95
Understanding How Templates Work ..................................................... 97
Getting the Scoop on the Normal Template ......................................... 98
Starting with a Template........................................................................ 101
Using Templates from the New Documents Dialog Box........................ 101
Creating Custom Templates.................................................................... 106
Creating a Template Based on an Existing Document......................... 107
Creating a Template Based on an Existing Template......................... 107
Creating a Template Based on a New, Blank Template....................... 107
Saving Your Template........................................................................... 107
Attaching Templates to Documents....................................................... 111
Working with Global Templates............................................................. 113
Manually Loading Global Templates...................................................... 114
Automatically Loading Global Templates............................................ 115
Unloading Global Templates................................................................... 115
Modifying Existing Templates............................................................... 116
Modifying an Existing Document Template File ............................... 117
Modifying an Existing Document Template While Working in a Document 117
Using the Organizer to Rename, Delete, and Copy Styles................... 117
Protecting Templates............................................................................. 119
What’s Next?......................................................................................... 120

Chapter 5

Applying Themes for a Professional Look ........................................... 121

Themes in Word 2007............................................................................. 121
What’s in a Theme?................................................................................ 122
Themes, Quick Styles, and Templates..................................................... 124
Trying Themes with Live Preview........................................................... 125
Changing a Theme................................................................................. 126
Changing Theme Colors....................................................................... 127
Choosing a New Font Selection............................................................. 128
Selecting Theme Effects........................................................................ 129
Creating a Custom Theme...................................................................... 130
Creating Your Own Color Scheme........................................................ 131
Customizing Theme Font Sets............................................................... 132
Saving Your Custom Theme................................................................. 133
What’s Next?........................................................................................ 133
# Part 2: Working with Content: From Research to Review

## Chapter 6
### Mastering Document Fundamentals
- Formatting Text and Paragraphs Efficiently ........................................ 137
- Specifying Fonts and Sizes .................................................................... 139
- Applying Text Attributes and Effects .................................................... 142
- Additional Text Formats ........................................................................ 144
- Changing Case ...................................................................................... 144
- Using the Highlight Tool ....................................................................... 145
- Changing Text Color ............................................................................ 146
- Working with Hidden Text .................................................................... 146
- Controlling Character Spacing .............................................................. 147
- Clearing Formatting Attributes .............................................................. 149
- Positioning Content Effectively ............................................................ 149
- Text Alignment Commands .................................................................... 149
- Inserting Symbols and Special Characters ............................................ 151
  - Inserting Symbols ............................................................................. 151
  - Inserting Special Characters ............................................................ 153
- Inserting Mathematical Equations ....................................................... 154
- Inserting Date and Time Elements ....................................................... 160
- Inserting Document Property Fields .................................................... 162
- What's Next? ....................................................................................... 165

## Chapter 7
### Honing Document Navigation Skills
- Navigating Easily in Word 2007 ............................................................. 167
- Accessing Document Areas Using the Document Map and Thumbnails ... 168
- Moving in the Document Using Shortcut and Function Keys ............... 170
- Navigating with Browse Object ............................................................ 172
- Finding Text and Elements Within the Current Document ..................... 174
  - Finding Instances of Formatting ...................................................... 176
  - Finding Special Characters Using Codes ......................................... 177
- Jumping to Document Areas Using Go To ............................................ 179
- Creating Bookmarks for Document Navigation ..................................... 180
  - Changing the View ........................................................................... 181
  - Displaying and Arranging Windows ................................................ 181
  - Split Window View .......................................................................... 182
  - Viewing Pages Side by Side ............................................................ 183
  - Switching among Multiple Windows .............................................. 184
- What's Next? ....................................................................................... 184

## Chapter 8
### Working with Building Blocks and Other Text Tools
- Tools at Your Fingertips ........................................................................ 185
- Building with Building Blocks ............................................................... 186
  - Inserting Existing Building Blocks .................................................... 189
  - Creating Building Blocks ................................................................... 192
  - Modifying Building Block Properties ............................................... 196
  - Deleting Building Blocks .................................................................. 198
Maximizing AutoCorrect ........................................................198
Controlling AutoCorrect While Working in Your Document ..............200
Linear Format: Math AutoCorrect ...........................................203
Using AutoFormat Effectively .............................................206
Getting ‘Smarter’ with Smart Tags ..........................................208
   Using Smart Tags ................................................................208
   Turning Off Smart Tags ....................................................210
   Rechecking Your Document .............................................210
   Obtaining Additional Smart Tags .......................................210
   Understanding Smart Tags ..............................................211
What’s Next? .....................................................................211

Chapter 9

Refining with Research Services and Reference Tools .................213
Translation Tools ..................................................................213
Using the Research Task Pane to Research Information ......................214
   Using Research Services ................................................214
   Controlling Research Services ......................................216
   Using Parental Control to Block Offensive Content ..............218
Building a Document’s Credibility by Using Spelling and Grammar Tools ..222
   Contextual Spelling Errors ...........................................222
   Benefiting from Automated Proofing ..................................223
Specifying a Proofing Language ..............................................226
Proofing an Entire Document ..................................................228
   Controlling Proofing Display and Exceptions ......................230
   Configuring Spelling Options .......................................232
   Configuring Grammar Options .....................................233
   Managing Custom Dictionaries ......................................235
   Creating an Exclusion Dictionary ....................................240
Scrutinizing Document Statistics .............................................242
   Judging a Document’s Readability Level ............................242
   Displaying Word Count Statistics ....................................243
What’s Next? ......................................................................244

Chapter 10

Outlining Documents for Clarity and Structure ..........................245
Outlining Enhancements in Word 2007 ....................................245
Presenting Creative Outlining with Word 2007 .............................246
Eleven Reasons to Outline Your Next Complex Document ..............247
Viewing a Document in Outline View .....................................249
   Exploring the Outlining Tools .......................................251
Creating a New Outline ......................................................252
Choosing Outline Display ....................................................254
   Displaying Different Levels of Text ..................................254
   Showing the First Line of Text ......................................255
   Removing and Showing Formatting ..................................256
Working with Headings in Outline View ...................................257
   Adding a Heading .........................................................257
   Applying Outline Levels ..............................................257
Part 3: Visual Elements: Tables, Charts, Diagrams, Pictures

Chapter 11 Organizing Concepts in Tables ................................................................. 267

Creating Tables in Word ......................................................................................... 268
Adding a Quick Table ............................................................................................. 268
Using the Row and Column Grid to Create a Table .................................................. 270
Inserting a Table and Specifying AutoFit Options ..................................................... 270
Drawing a Table ....................................................................................................... 271
Converting Text to a Table ....................................................................................... 272
Inserting an Excel Spreadsheet .................................................................................. 272

Creating Nested Tables ............................................................................................ 273

Editing Tables ........................................................................................................... 274
Displaying Table Formatting Marks ....................................................................... 274
Selecting Table Cells ............................................................................................... 276
Copying and Pasting Table Data ............................................................................. 276
Inserting Columns and Rows ................................................................................... 277
Inserting Cells .......................................................................................................... 278
Deleting Columns, Rows, and Cells ....................................................................... 278
Moving Rows and Columns ...................................................................................... 279
Merging Cells ........................................................................................................... 279
Splitting Cells .......................................................................................................... 279

Resizing Tables ......................................................................................................... 280
Understanding AutoFit ............................................................................................ 280
Resizing an Entire Table ........................................................................................... 281
Changing Column Width and Row Height ............................................................... 282
Distributing Data Evenly in Rows and Columns ....................................................... 282
Changing Text Direction ......................................................................................... 282

Enhancing Your Tables with Formatting ................................................................. 282
Changing Table Format by Using Table Styles ....................................................... 283
Creating Your Own Table Styles ............................................................................. 285
More Formatting Fun ............................................................................................... 286
Positioning Tables in Your Document ..................................................................... 286
Flowing Text Around Tables .................................................................................... 287

Working with Functions in Tables ........................................................................... 288

What's Next? ............................................................................................................. 289

Chapter 12 Showcasing Data with SmartArt and Charts ........................................... 291

Adding SmartArt Diagrams ...................................................................................... 291
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating the SmartArt Diagram</td>
<td>292</td>
</tr>
<tr>
<td>Adding and Formatting Diagram Text</td>
<td>294</td>
</tr>
<tr>
<td>Making Formatting Changes in the Diagram</td>
<td>295</td>
</tr>
<tr>
<td>Creative Charting</td>
<td>297</td>
</tr>
<tr>
<td>Introducing Word 2007 Chart Types</td>
<td>298</td>
</tr>
<tr>
<td>Charting Changes in Microsoft Office 2007</td>
<td>300</td>
</tr>
<tr>
<td>Creating a Basic Chart</td>
<td>300</td>
</tr>
<tr>
<td>Changing the Chart Type</td>
<td>302</td>
</tr>
<tr>
<td>Creating a Chart Template</td>
<td>303</td>
</tr>
<tr>
<td>Understanding the Chart Tools</td>
<td>304</td>
</tr>
<tr>
<td>Entering Chart Data</td>
<td>306</td>
</tr>
<tr>
<td>Working with the Datasheet</td>
<td>306</td>
</tr>
<tr>
<td>Changing the Data Arrangement</td>
<td>309</td>
</tr>
<tr>
<td>Editing and Enhancing Chart Information</td>
<td>309</td>
</tr>
<tr>
<td>Choosing a New Chart Layout</td>
<td>310</td>
</tr>
<tr>
<td>Applying a Chart Style</td>
<td>311</td>
</tr>
<tr>
<td>Adding a Chart Title</td>
<td>312</td>
</tr>
<tr>
<td>Working with Axes</td>
<td>313</td>
</tr>
<tr>
<td>Add Gridlines and Trendlines</td>
<td>315</td>
</tr>
<tr>
<td>Displaying and Positioning a Legend</td>
<td>316</td>
</tr>
<tr>
<td>Working with Data Labels</td>
<td>317</td>
</tr>
<tr>
<td>Formatting Charts</td>
<td>319</td>
</tr>
<tr>
<td>Changing the Format of Your Chart Elements</td>
<td>320</td>
</tr>
<tr>
<td>Formatting Shapes</td>
<td>321</td>
</tr>
<tr>
<td>What’s Next?</td>
<td>322</td>
</tr>
<tr>
<td>Chapter 13: Adding Visual Impact with Pictures, Drawings, and WordArt</td>
<td>323</td>
</tr>
<tr>
<td>Adding Art to Your Word Documents</td>
<td>323</td>
</tr>
<tr>
<td>Inserting Pictures</td>
<td>324</td>
</tr>
<tr>
<td>Adding Clip Art</td>
<td>325</td>
</tr>
<tr>
<td>Adding Shapes and Lines</td>
<td>327</td>
</tr>
<tr>
<td>Adding WordArt</td>
<td>330</td>
</tr>
<tr>
<td>Enhancing Pictures</td>
<td>331</td>
</tr>
<tr>
<td>Applying Picture Styles to Your Images</td>
<td>331</td>
</tr>
<tr>
<td>Editing and Adjusting Images</td>
<td>334</td>
</tr>
<tr>
<td>Cropping Pictures</td>
<td>335</td>
</tr>
<tr>
<td>Resizing Pictures</td>
<td>337</td>
</tr>
<tr>
<td>Rotating Pictures</td>
<td>338</td>
</tr>
<tr>
<td>Adding Captions to Pictures</td>
<td>338</td>
</tr>
<tr>
<td>Modifying Drawings</td>
<td>339</td>
</tr>
<tr>
<td>Applying Shape Styles</td>
<td>340</td>
</tr>
<tr>
<td>Adding and Formatting Shape Text</td>
<td>341</td>
</tr>
<tr>
<td>Modifying Lines and Fills</td>
<td>342</td>
</tr>
<tr>
<td>Formatting Shadows and 3-D Effects</td>
<td>343</td>
</tr>
<tr>
<td>Applying and Customizing 3-D Effects</td>
<td>346</td>
</tr>
<tr>
<td>Arranging Art on the Page</td>
<td>349</td>
</tr>
<tr>
<td>Aligning Objects</td>
<td>349</td>
</tr>
</tbody>
</table>
Grouping and Ungrouping Objects .................................................. 351
Controlling Object Layering .......................................................... 352
Choosing Art Position ................................................................. 352
Controlling Text Wrapping ........................................................... 353
What's Next? ............................................................................. 354

Part 4: Professional Polish: Lists, Styles, Backgrounds, and Borders

Chapter 14    Aligning Information and Formatting Paragraphs and Lists .... 357
Paragrapth in Word Documents—More than Thematic Blocks of Text .... 358
Formatting Paragraphs by Aligning and Indenting Text .................. 360
Using the Ruler to Align Paragraphs .......................................... 361
Aligning Paragraphs by Using the Paragraph Dialog Box ............ 363
Addressing Spacing Issues ............................................................. 366
Specifying Line Spacing ............................................................... 368
Adjusting Spacing Above and Below Paragraphs ....................... 369
Controlling Alignment by Using Tabs ......................................... 370
Putting the Ruler to Work to Set Tabs ........................................ 372
Creating Tabs by Using the Tabs Dialog Box ................................. 373
Clearing Manual Tabs .................................................................. 375
Controlling Line and Page Breaks ............................................... 376
Taking Control of Hyphenation ..................................................... 377
Hyphenate an Entire Document Automatically ........................... 378
Hyphenating All or Part of a Document Manually ....................... 379
Creating Drop Caps in Existing Paragraphs ................................ 380
Creating Effective Lists ................................................................. 381
When Bullets Work ..................................................................... 382
When Numbers Matter .................................................................. 382
Creating a Quick List .................................................................... 384
Creating Lists While You Type ..................................................... 385
Ending a List, the Way You Want .................................................. 386
Enhancing Bulleted Lists ............................................................... 386
Choosing a New Bullet from the Bullet Library ........................... 386
Selecting a Bullet Character Outside the Bullet Gallery ............... 387
Changing the Bullet Font ............................................................... 388
Changing a Bullet Symbol ............................................................ 388
Using a Picture Bullet ................................................................... 389
Improving Numbered Lists ........................................................... 390
Choosing a Numbering Scheme .................................................... 390
Modifying the Numbering Style ................................................... 391
Continuing Numbering ................................................................. 392
Restarting Numbering ................................................................. 393
Converting a Bulleted List to a Numbered List (or Vice Versa) ...... 393
Changing List Indents ................................................................... 394
Creating and Using Multilevel Lists .............................................. 395
Creating a New List Style .............................................................. 397
Modifying a List Style ................................................................. 400
What's Next? ............................................................................. 401
# Chapter 15

**Using Styles to Increase Your Formatting Power**
- Chapter Assumptions ........................................................... 404
- Formatting Fundamentals ...................................................... 404
  - Style Fundamentals ....................................................... 406
- Understanding the Quick Style Gallery and Quick Style Sets .......... 409
  - Applying and Modifying Styles Using the Quick Style Gallery ......... 410
  - Switching and Modifying Quick Style Sets ................................ 411
- Custom Quick Style Sets ...................................................... 413
- Making Styles Work for You .................................................. 415
  - Mastering the Styles Pane ................................................ 417
- Creating and Modifying Styles .............................................. 421
  - Modifying Existing Styles .................................................. 423
- Additional Style Options .................................................... 424
- Style Management Tools ..................................................... 426
  - Inspecting Styles ............................................................ 426
  - Reveal Formatting Task Pane .............................................. 427
- Managing Styles ............................................................... 431
  - Keyboard Shortcuts for Styles ............................................ 436
- Some Final Thoughts on Styles ............................................. 438
- What’s Next? ................................................................. 438

# Chapter 16

**Formatting Layouts Using Backgrounds, Watermarks, and Text Boxes**
- Layout and Design Fundamentals .......................................... 440
- Using Backgrounds and Watermarks ....................................... 441
  - Creating Backgrounds and Watermarks .................................. 441
  - Changing and Removing Backgrounds and Watermarks ................. 446
- Controlling Text Placement with Text Boxes and Shapes .............. 447
  - Adding Text Boxes ......................................................... 448
  - Inserting Text into Text Boxes .......................................... 450
  - Formatting Text Boxes ...................................................... 451
- Linking Text Boxes to Flow Text .......................................... 455
  - Moving Between Linked Text Boxes ..................................... 457
  - Copying or Moving Linked Text Boxes ................................... 457
  - Breaking Text Box Links .................................................. 459
  - Deleting Linked Text Boxes Without Losing Text ..................... 460
- Configuring Word 2007 Layout Options ................................ 460
- What’s Next? ................................................................. 461

# Chapter 17

**Commanding Attention with Borders and Shading**
- Adding a Simple Border ...................................................... 463
- Creating Enhanced Borders ................................................ 465
  - Choosing Border Options .................................................. 466
  - Selecting Line Styles for Borders ........................................ 468
  - Choosing Color ............................................................. 469
  - Controlling Border Width ................................................... 471
- Creating Partial Borders .................................................... 472
## Chapter 19

### Revising Documents Using Markup Tools

- Benefits of an Organized Revision Process .............................................. 524
- Familiarizing Yourself with Markup Tools .................................................. 524
- Configuring Reviewer Settings ...................................................................... 527
  - Configuring Colors Associated with Reviewers ........................................... 528
- Viewing Comments and Revisions .................................................................. 530
- Adding and Managing Comments Effectively ................................................. 532
  - Inserting Standard Comments ...................................................................... 532
  - Inserting Voice and Handwritten Comments ............................................... 533
- Tracking Changes ............................................................................................ 534
  - Tracking Changes While You Edit ................................................................. 535
  - Adjusting the Appearance of Tracked Changes .............................................. 537
  - Tracking Moved Text and Inline Shapes ....................................................... 538
  - Showing Revisions in Tables ................................................................-------- 538
  - Customizing the Appearance of Changed Lines .......................................... 539
- Configuring Balloon and Reviewing Pane Options ....................................... 539
  - Balloon and Reviewing Pane Styles ............................................................. 540
  - Showing and Hiding Balloons ....................................................................... 540
  - Adjusting Balloon Size and Location for Online Viewing ............................. 541
- Printing Comments and Tracked Changes ..................................................... 543
- Reviewing Comments and Tracked Changes .................................................. 544
  - Responding to Comments ............................................................................ 546
  - Deleting Comments ..................................................................................... 546
  - Accepting and Rejecting Proposed Edits ...................................................... 547
- Protecting a Document for Comments or Revisions ....................................... 551
- Comparing or Combining Documents ............................................................. 554
  - Comparing Two Versions of a Document (Legal Blackline) ............................ 555
  - Combining Revisions from Multiple Authors .............................................. 557
- What’s Next? .................................................................................................... 559

## Chapter 20

### Addressing Document Protection and Security Issues

- Protection Features in Word ........................................................................... 562
- Encrypting Documents .................................................................................... 563
  - Removing Protection ................................................................................... 565
- Applying Formatting Restrictions ..................................................................... 565
- Restricting Tracked Changes, Comments, and Forms ..................................... 568
- Removing Personal Information and Hidden Data .......................................... 570
  - Removing Personal Information .................................................................. 570
- Preparing PDF and XPS Files .......................................................................... 571
  - Download the PDF and XPS Utility ............................................................... 572
  - Understanding PDF and XPS ....................................................................... 572
  - Saving Your Document as PDF and XPS ....................................................... 572
Part 6: Complex Documents: Sections, Master Documents, and References

Chapter 21
Formatting Columns and Sections for Advanced Text Control ................. 589
The Nature of Complex Documents ................................................. 589
Creating a Cover Page ............................................................... 591
Planning Your Document ............................................................ 593
Working with Predesigned Columns ............................................. 594
Creating a Multi-Column Document ............................................. 595
Using the Columns Button ........................................................... 595
Choosing Column Specs in the Columns Dialog Box ......................... 596
Creating Columns for Part of a Document ...................................... 597
Creating Unequal Column Widths ............................................... 599
Changing Column Width on the Ruler ......................................... 599
Flowing Text into a Column Layout ............................................. 601
Choosing Text Alignment ............................................................ 602
Beginning a New Column Layout ............................................... 603
Inserting Column Breaks ............................................................. 603
Removing Column Breaks ........................................................... 604
Working in Sections ..................................................................... 605
Creating a Section ....................................................................... 605
Removing Section Breaks .............................................................. 606
Using Line Numbers ..................................................................... 608
Deleting Line Numbers ............................................................... 610
What’s Next? ............................................................................. 610

Chapter 22
Creating and Controlling Master Documents ......................................... 611
When Master Documents Make Sense ............................................. 612
Getting Started with a Master Document ....................................... 613
Displaying Master Document and Subdocument Tools ...................... 613
What’s in a Master Document? ...................................................... 614
Preparing Master Documents and Subdocuments .............................. 615
### Chapter 24 Generating First-Class Tables of Contents and Reference Tables

- Creating Effective Reference Tables ........................................... 652
- Creating a Table of Contents .................................................. 652
  - Using a TOC Style .................................................................. 653
  - Creating a Customized TOC .................................................. 654
  - Adding TOC Entries Manually .............................................. 657
  - Choosing a Format .................................................................. 658
  - Editing and Updating a TOC .................................................. 659
- Preparing a TOC for the Web .................................................... 660
- Customizing a TOC .................................................................. 661
  - Matching Entry Styles to TOC Levels .................................. 662
  - Changing TOC Styles .......................................................... 662
- Incorporating Other Reference Tables ...................................... 663
  - Building a Table of Figures .................................................. 663
  - Generating a Table of Figures .............................................. 665
  - Building a Table of Authorities ............................................ 666
  - Generating the Table of Authorities ...................................... 667
- What's Next? ........................................................................... 668

### Chapter 25 Creating Effective Indexes

- Anatomy of an Index .............................................................. 669
- What Makes a Good Index? ..................................................... 670
- Indexing with Word ............................................................... 671
- Creating Index Entries ............................................................ 672
  - Marking Index Entries ....................................................... 672
  - Creating Subentries ........................................................... 673
  - Selecting Repeated Entries ................................................ 674
  - Formatting Entries ............................................................. 674
  - Adding Cross-References .................................................... 675
  - Specifying Page Ranges ...................................................... 675
- Generating an Index ............................................................... 676
  - Choosing the Index Format ................................................ 677
  - Choosing Alignment ........................................................... 678
  - Changing the Way Entries Are Displayed ............................. 678
  - Changing Index Columns ..................................................... 679
- Updating an Index .................................................................. 680
- AutoMarking Entries with a Concordance File .......................... 680
- What's Next? ........................................................................... 682

### Part 7: Publishing: Word to the World

### Chapter 26 Printing with Precision

- Print vs. Digital ...................................................................... 685
- Previewing Before Printing ..................................................... 686
  - Getting Comfortable in Print Preview ................................ 687
  - Zooming In on the Details ................................................... 690
  - Editing in Print Preview ....................................................... 693
Printing Quickly and Efficiently ................................................................. 696
Canceling a Print Job ............................................................................... 697
Using the Print Dialog Box ................................................................. 699
  Printing More than One Copy of a Single Document ...................... 699
  Printing Ranges .................................................................................. 700
  Printing Document Elements ......................................................... 701
  Printing Several Pages per Sheet .................................................. 704
  Scaling Printed Documents .............................................................. 704
Setting Other Printing Options ......................................................... 705
Printing Individual Labels and Envelopes ........................................ 707
  Creating Labels .................................................................................. 710
What’s Next? ......................................................................................... 711

Chapter 27
Blogging from Word 2007 ................................................................. 713
A Brief Blogging Introduction ............................................................ 713
Starting a New Blog Post ................................................................. 715
  Entering Text ...................................................................................... 717
  Inserting a Web Link ....................................................................... 717
  Adding a Category to Your Post .................................................... 718
  Adding a Picture to Your Post ......................................................... 720
Configuring Your Blog Account .......................................................... 722
What’s Next? ......................................................................................... 724

Chapter 28
Performing Mail Merges ................................................................. 725
Mail Merge Overview ........................................................................... 725
Know Your Merge Terms ................................................................. 726
Starting the Mail Merge Project .......................................................... 727
Selecting the Document Type ............................................................ 727
Starting Out with the Main Document ............................................... 728
  Using the Current Document .......................................................... 729
  Starting from a Template ................................................................. 729
  Starting from an Existing Document ............................................... 731
Choosing Your Recipients ................................................................. 731
  Creating a New List .......................................................................... 732
  Using an Existing Recipient List .................................................... 733
  Choosing Outlook Contacts ............................................................ 734
Choosing and Sorting Recipient Information ..................................... 735
  Filtering Your Recipient List ........................................................... 736
Adding Merge Fields ................................................................. 737
  Inserting an Address Block .............................................................. 738
  Choosing a Greeting Line ................................................................ 740
  Inserting Merge Fields .................................................................... 741
  Matching Fields with Your Database ............................................. 743
  Adding Word Fields ....................................................................... 744
Previewing the Merge ................................................................. 745
  Finding a Specific Entry ................................................................... 746
Checking for Errors ............................................................................ 746
### Table of Contents

#### Chapter 29

**Customizing Documents with Content Controls.** ....... 753
- Understanding the Word 2007 Content Controls .............. 754
- Integrating Data and Processes with Content Controls .... 754
- Creating the Document ............................................ 755
- Displaying the Developer Tab .................................... 755
- Adding and Formatting Static Text .............................. 757
- Adding Content Controls .......................................... 759
  - Control Types in Word 2007 .................................. 761
  - Adding a Control ................................................ 765
- Changing Content Control Properties ........................ 766
  - Adding Titles and Tags ......................................... 767
  - Styling Your Control ........................................... 768
  - Locking Controls ............................................... 770
  - Adding Content to Lists ....................................... 770
  - Mapping Controls to XML ...................................... 771
- Using Content Controls ........................................... 772
- Protecting Documents ............................................. 772
- Adding Legacy Controls ........................................... 775
- Adding ActiveX Controls ......................................... 776
  - ActiveX Controls and the Trust Center ....................... 776
  - Adding an ActiveX Control .................................... 777
  - Changing Control Properties ................................. 777
  - Programming a Control ....................................... 778
- What’s Next? .......................................................... 778

#### Chapter 30

**Working with XML.** ................................................. 779
- XML—Then and Now ................................................ 780
  - Something New on the Way .................................... 780
  - Word 2007 XML .................................................. 780
- The Benefits of XML in Word 2007 .............................. 781
  - Faster, Smaller Files .......................................... 782
  - Better Data Recovery ......................................... 783
  - Reusable Content ............................................... 783
  - Map Your Data to Business Processes ....................... 784
  - Make Your Own Rules ......................................... 784
  - An Inside Look at a Word 2007 XML Document ............ 784
- Introduction to XML ................................................. 790
- XML Glossary ........................................................ 790
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Defined</td>
<td>791</td>
</tr>
<tr>
<td>Working with Custom XML in Word 2007</td>
<td>793</td>
</tr>
<tr>
<td>Displaying Word 2007 XML Tools</td>
<td>793</td>
</tr>
<tr>
<td>Attaching a Custom XML Schema</td>
<td>794</td>
</tr>
<tr>
<td>Adding a Schema to the List</td>
<td>797</td>
</tr>
<tr>
<td>Working with the Schema Library</td>
<td>797</td>
</tr>
<tr>
<td>Tagging Word Content</td>
<td>797</td>
</tr>
<tr>
<td>Removing XML Tags</td>
<td>800</td>
</tr>
<tr>
<td>Setting XML Options</td>
<td>800</td>
</tr>
<tr>
<td>What’s Next?</td>
<td>803</td>
</tr>
</tbody>
</table>

**Chapter 31**

Working with Macros and VBA ........................................... 805

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Bit About VBA and Macros</td>
<td>806</td>
</tr>
<tr>
<td>Saving Macro-Enabled Documents and Templates</td>
<td>807</td>
</tr>
<tr>
<td>Recording a Macro</td>
<td>808</td>
</tr>
<tr>
<td>Setup and Planning</td>
<td>808</td>
</tr>
<tr>
<td>Running Macros</td>
<td>813</td>
</tr>
<tr>
<td>Adding a Macro to the Quick Access Toolbar</td>
<td>813</td>
</tr>
<tr>
<td>Assigning a Keyboard Shortcut to a Macro</td>
<td>817</td>
</tr>
<tr>
<td>Running a Macro Automatically</td>
<td>819</td>
</tr>
<tr>
<td>Editing Macros</td>
<td>821</td>
</tr>
<tr>
<td>The Visual Basic Editor</td>
<td>823</td>
</tr>
<tr>
<td>Recording Built-in Dialog Box Options</td>
<td>825</td>
</tr>
<tr>
<td>Additional Macro Options</td>
<td>827</td>
</tr>
<tr>
<td>Renaming a Macro, Module, or Project</td>
<td>827</td>
</tr>
<tr>
<td>Deleting and Exporting Macros and Modules</td>
<td>829</td>
</tr>
<tr>
<td>Importing Macros and Modules</td>
<td>830</td>
</tr>
<tr>
<td>Protecting Your Macros</td>
<td>831</td>
</tr>
<tr>
<td>Digitally Signing Macros</td>
<td>832</td>
</tr>
<tr>
<td>Third-Party Digital Signature</td>
<td>833</td>
</tr>
<tr>
<td>Creating a Self-Signed Digital Signature</td>
<td>833</td>
</tr>
<tr>
<td>Digitally Signing a VBA Project</td>
<td>834</td>
</tr>
<tr>
<td>What’s Next?</td>
<td>836</td>
</tr>
</tbody>
</table>

Index to Troubleshooting Topics ................................ 837

Index ................................................................. 841

What do you think of this book? We want to hear from you!

Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources for you. To participate in a brief online survey, please visit:

Microsoft Office Word 2007 includes a number of tools designed to help you speed up typing repetitive text and those monotonous tasks you might face daily or deal with those infrequent tasks that you rarely carry out that usually take a few moments to refresh your memory. These tasks might range from typing the name of your company or department hundreds of times a day (or at least it feels like it) or recalling how to spell what must be one of the longest words in the dictionary to reusing frequently used document content, such as adding a fax cover page to a document, inserting a logo or certain graphic, adding headers or footers in a specific format; creating standardized tables, and inserting certain equations—most of which you can easily perform but are time consuming.

One of the tools that will assist you with your productivity is a long-standing, favorite time-saving feature that has been completely redesigned from the ground up and is now more powerful and more visible than ever before—an improvement so far-reaching that its old name could no longer adequately describe its new functionality. What was formerly known as AutoText has been reborn in Office Word 2007 as Building Blocks and is the primary focus of this chapter. You’ll also find other time-saving text tools, such as AutoCorrect, AutoFormat, and Smart Tags, all of which have been around for several versions, along with a new member of the AutoCorrect family, Math AutoCorrect, which brings the new Equation Builder functionality to your fingertips and facilitates creating equations by using a keyboard-based syntax.

Tools at Your Fingertips

All of the tools in this chapter play key roles in speeding up productivity and, in many instances, more than one can be used to accomplish the same result. To determine the best tool for your needs, the following list is a summary of the role that each tool plays in document creation.

- **Building Blocks** Reusable pieces of content that can be inserted into a document from various built-in or custom galleries and can be used in combination with Content Controls. Can store any type of document content such as text, tables,
illustrations, headers, footers, text boxes, equations, and more. Best tool for large amounts of data. Uses visual and mouse-based insertion, but can also be inserted by using the keyboard. For more information on Building Blocks, see the next section titled “Building with Building Blocks.”

- **AutoCorrect** Designed to aid in error correction by automatically correcting typographical errors as you type. Can also be used as a shorthand method for typing repetitive phrases and complex spelling. The latter is the best tool for heavy keyboarding, albeit it does require a bit of memorization. See the section titled “Maximizing AutoCorrect” later in this chapter to learn more about putting this tool to work and how to control those unexpected automatic changes.

- **Math AutoCorrect** Works in combination with the new Equation Builder and enables the creation of equations by using Linear Format, a keyboard-based syntax, that uses TeX-like notation and converts strings to symbols or groups of characters. Best for creating equations by using the keyboard. Like AutoCorrect, it does require some memorization to take advantage of its full potential. For more information, see the section titled “Linear Format: Math AutoCorrect” later in this chapter.

- **AutoFormat** Enables quick insertion of common symbols, such as an en or em dash and common fractions. Converts straight quotes to smart quotes as well as URLs and e-mail addresses into hyperlinks. Automatically creates tables, numbered and bulleted lists, and aids in other formatting tasks, such as adding indents and defining styles. Get in-depth coverage in the section titled “Using AutoFormat Effectively” later in this chapter.

- **Smart Tags** Recognizes specific types of text and allows you to perform actions related to the type of data, such as measurement conversions, getting the latest information on your favorite stock, obtaining a map or driving directions from an address, and more. For additional information, see the section titled “Getting ‘Smarter’ with Smart Tags” later in this chapter.

### Building with Building Blocks

After spending a short amount of time using Word 2007, you’ll quickly spot the many Building Block galleries available to you while you work. Headers, Footers, Page Numbers, Text Boxes, Cover Pages, Watermarks, Quick Tables, Tables of Contents, Bibliographies, and Equations were created to help you build professional-looking documents quickly and efficiently. The built-in Building Blocks are Theme enabled, which means that if you modify the document Theme, the formats automatically update—even in the Building Block galleries.

You can customize Building Block entries to fit your needs, import new Building Blocks from Microsoft Office Online (www.office.microsoft.com), create custom Building Blocks and add them to their relevant galleries, or use custom galleries that can be added easily to your Quick Access Toolbar. You can view the many Building Blocks by browsing the various galleries, or you can check out the entire collection at once by
opening the Building Blocks Organizer, found on the Insert tab under the Quick Parts options, as shown in Figure 8-1.

![Building Blocks Organizer](image)

**Figure 8-1** The Building Blocks Organizer provides quick access to built-in and custom Building Blocks.

Unlike its predecessor, built-in Building Blocks are not stored in the Normal template, but rather in a specific template named Building Blocks.dotx. This template is loaded as a global template the first time you access a Building Block gallery or the Building Blocks Organizer in your current Word session, so it’s not uncommon to initially experience a slight delay while the Building Blocks load.

**TROUBLESHOOTING**

**My Building Block galleries are missing or Building Blocks.dotx is corrupt**

If you encounter a message stating that Building Blocks.dotx is corrupt or if the Building Block galleries are missing, then this issue can be resolved by using one of the following methods:
If you use Symantec’s Norton AntiVirus or if it has ever been installed on your computer, its Office Plug-in option is known to cause an error message stating that Building Blocks.dotx is corrupt. To rectify this issue, take the following steps:

1. Exit Word and open Norton AntiVirus.
2. Click Options, click Miscellaneous, and clear the Enable Office Plug-in check box.

For more information go to the Microsoft Knowledge base and search for Article ID 329820, “How to use Office programs with the Norton AntiVirus Office plug-in” (http://support.microsoft.com/kb/329820).

If you do not use Norton AntiVirus or if the Office Plug-in is disabled, then re-create your personal copy of Building Blocks.dotx by using the following steps:

1. Exit Word and navigate to Building Blocks.dotx by using one of the following locations.
   - For Windows Vista: C:\Users\user name\AppData\Roaming\Microsoft\Document Building Blocks\1033
   - For Windows XP: C:\Documents and Settings\user name\Application Data\Microsoft\Document Building Blocks\1033

   Note
   The numbered folder is specific to your language version of Word. For example, 1033 is an English language folder.

2. Move or delete Building Blocks.dotx, and a new one is created the next time you access a Building Block gallery or the Building Blocks Organizer.

   Note that Building Blocks .dotx cannot be renamed. It must be moved out of the Document Building Blocks folder or deleted; otherwise, it will continue to load.

Finally, there are two Building Blocks.dotx files used by Word. There is also a master Building Blocks.dotx file, located in the Office installation path, that is used to create your personal copy of Building Blocks.dotx and should not be deleted.

To familiarize yourself with the various built-in Building Blocks, scroll through the Building Blocks Organizer to view them. You can click any entry to preview the Building Block in the organizer’s preview pane. Note that, unlike the Building Block galleries, the preview does not automatically update to the current document Theme. The list of Building Blocks in the organizer is sorted by the name of the gallery by default. You can sort Building Blocks by Name, Gallery, Category, Template, Behavior, or Description by clicking a column heading in the organizer. If you are unable to see all of the columns, use the scroll bar at the bottom to view them.
**Tip**

While viewing a Building Block gallery, you can quickly locate a Building Blocks entry in the Building Blocks Organizer by right-clicking a Building Block, such as a Cover Page or a Header, and then clicking Organize And Delete. The Building Blocks Organizer opens with the entry selected automatically.

**Inserting Existing Building Blocks**

You can insert a Building Block in a document simply by clicking the Building Block on its corresponding gallery (such as the Text Box gallery available on the Insert tab). A few of the various Building Block galleries that you’ll find in Word 2007 are shown in Figure 8-2. Alternatively, use the Building Blocks Organizer to preview and insert a Building Block in your document. Note that you cannot double-click a Building Block name to insert it from the organizer—you must click the Insert button.

**Tip**

Former Word users may be familiar with an AutoComplete tip that displays after typing the first few characters of the AutoText entry. The increased number of built-in Building Blocks also increased the likelihood of inadvertently inserting them into your document, and this capability is now removed. However, AutoComplete is still available for the current system date, months, and days of the week.

If you want to insert Building Blocks by using the keyboard, type the Building Block name and then press F3.
Figure 8-2 Building Block galleries provide a quick visual method for inserting reusable content in your documents.

A Building Block gallery can be added to your Quick Access Toolbar by right-clicking the gallery button on the Ribbon and then clicking Add To Quick Access Toolbar. Some Building Block galleries, such as the Cover Page, Table of Contents, and Quick Table galleries, contain additional commands on the shortcut menu. For example, if you right-click a Building Block in the Cover Pages gallery (a Building Block entry rather than the button on the Ribbon), you’ll find Insert At Beginning Of Document, Insert At Current Document Position, Insert At Beginning Of Section, Insert At End Of Section, or Insert At End Of Document. If you right-click a Building Block in the Quick Tables gallery that is found on the Insert Tab under Table options, you’ll also find Insert At Page Header (beginning of the current page) and Insert At Page Footer (end of the current page), as shown in Figure 8-3.
Figure 8-3  Right-click a Building Block entry to obtain additional options.

After you insert a Building Block, you can freely customize the Building Block’s formatting and properties without affecting the Building Block stored in the template.

TROUBLESHOOTING
What happened to my AutoText entries?

If you upgraded Word from a previous version, then you might find that previously created AutoText entries stored in your Normal template are missing and do not appear in the Building Blocks Organizer. This is typically due to Word using a new Normal.dotm file instead of your old Normal.dot file from the previous version. To resolve this issue, take the following steps:

1. Exit Word and locate Normal.dotm. (If you do not know where Normal.dotm is located, use Windows Search or refer back to Chapter 4, “Formatting Documents Using Templates,” and the section titled “Getting the Scoop on the Normal Template.”)

2. Locate your Normal.dot file and, if necessary, place it in the same location as Normal.dotm.

3. Rename Normal.dotm to OldNormal.dotm.

4. Right-click Normal.dot and click Open (do not double-click the file). Word should start and Normal.dot should open in Word.

5. Click the Microsoft Office Button and then click Convert to convert Normal.dot to the new file format. Save Normal.dot as Normal.dotx. (Word will convert it to Normal.dotm automatically.)

6. Close Normal.dotx, navigate to the Insert tab, click Quick Parts, and then click Building Blocks Organizer.

Your old AutoText entries should now be listed in the organizer in the AutoText gallery.
If you prefer to keep your Building Blocks in one location, such as Building Blocks.dotx, you can move your old AutoText entries to Building Blocks.dotx by using the Edit Properties button at the bottom of the organizer and changing the Save In template to Building Blocks.dotx. For more information on moving, modifying, and redefining Building Block entries, see the section titled “Modifying Building Block Properties” later in this chapter.

Creating Building Blocks

Frequently used document content, such as a paragraph or several paragraphs of data, logos, graphics, specifically formatted headers or footers, standard tables, or equations—any type of content—can be easily turned into a Building Block. You can create Building Blocks from newly created content or even data from documents that were created in previous versions of Word. Simply select the data that you want to turn into a reusable Building Block. On the Insert tab, click Quick Parts, and then click Save Selection To Quick Part Gallery, or press Alt+F3. The Create New Building Block dialog box displays as shown in Figure 8-4.

Tip

If you want to include all paragraph formatting, such as style, line spacing, indentation, alignment, and so forth, select the paragraph mark (¶) along with your content. If you aren’t already viewing formatting marks, navigate to the Home tab and, in the Paragraph group, click the Show/Hide ¶ button to toggle the formatting marks so you can verify that you included the paragraph mark in your selection. If you do not include the paragraph mark, the inserted Building Block will match the formatting of the current paragraph.

If you want your Building Blocks to be Theme enabled so that the formats update automatically, then use Theme fonts and colors from the Theme Color section of the color palettes.
The Create New Building Block dialog box enables you to name, classify, describe, and control the placement of Building Blocks that you create.

The Create New Building Block dialog box contains the following options:

- **Name** Enter a unique name for the Building Block. If you have a set of related Building Blocks, consider starting all of the names with the same first word to group the pieces together when necessary, such as Annual Report Cover, Annual Report Header, and Annual Report Table.

- **Gallery** Add your new Building Block to a specific gallery, such as Cover Pages, Page Numbers, Headers, Footers, Quick Tables, Watermarks, and so on. If your Building Block is a general Building Block and isn’t related to an existing gallery, use Quick Parts so that they will appear under the Quick Parts gallery. To use the Custom galleries or the AutoText gallery, see the Inside Out tip titled “Using Custom Galleries and the AutoText Gallery” later in this chapter.

**Tip**

Some Building Block galleries perform additional actions when you insert a Building Block from the gallery. For example, a Cover Page is added as the first page or is swapped with another previously inserted Cover Page. Headers, Footers, and Page Numbers are inserted in the Header and Footer layer in the document. To view other actions, right-click the Building Block entry and use an alternate command, shown previously in Figure 8-3.

- **Category** Place the Building Block in a category, shown on the Building Block galleries and in the Building Blocks Organizer. Consider creating a new category for your company or department so that all of the associated Building Blocks are placed in the same category throughout the Building Block galleries and to quickly sort them in the Building Blocks Organizer.
Tip
To display your Building Blocks at the top of the Building Block galleries, create a Category name that starts with a symbol, such as an asterisk, or place the name in parentheses.

- **Description** Provide a brief description to help remind you and inform others about the main purpose of the Building Block. Descriptions appear as enhanced ScreenTips in the Building Block gallery (provided that Show Feature Descriptions In Screen Tip is turned on in Word Options) and also appear below the preview pane when you select a Building Block in the Building Blocks Organizer.

- **Save In** Building Blocks can only be saved in templates. You can save Building Blocks in Building Blocks.dotx (selected by default), Normal.dotm, or a global template so that they are available to all open documents. They can also be saved in a document template that makes the Building Blocks available only to documents using that template. The Save In list contains Building Blocks.dotx, Normal.dotm, loaded global templates, the attached document template for the active document if it’s a template other than Normal.dotm, and any saved template provided that it is open and the current file. If you are creating Building Blocks to share with others, you want to save your Building Blocks in a separate template so you can distribute them. For more information on templates, see Chapter 4. For more information on sharing Building Blocks, see the Inside Out tip titled “Sharing Custom Building Blocks” later in this chapter.

Note
If you save or modify a Building Block in Building Blocks.dotx, Normal.dotx (provided that the Prompt Before Saving Normal Template option is turned on in the Advanced area of Word Options), or a global template, you are prompted to save changes to the template when you exit Word. For attached document templates, you are prompted to save changes to the template on closing the document.

- **Options** Specify whether the Building Block should be Inserted As Content only at the location of the cursor (such as an equation), Inserted In Its Own Paragraph (such as a heading), or Inserted In Its Own Page (inserts a page break before and after the Building Block).

Tip
Use the Save Selection To Gallery Name gallery found at the bottom of the Building Block galleries to quickly access the Create New Building Block dialog box and automatically select the corresponding gallery in the dialog box.
The following image displays a few custom Building Blocks assigned to different Building Block galleries by using a custom Category name (Coral Reef Divers) to place them at the tops of the galleries so that they can be easily found for quick insertion.

For a template containing several examples of custom Building Blocks, see “Sample Building Blocks.dotx” on this book’s companion CD.

INSIDE OUT

Sharing Custom Building Blocks

To share custom Building Blocks, they should be saved in a template other than Building Blocks.dotx or Normal.dotm so that they can be easily distributed. If you have a set of company or department Building Blocks that need to be shared with multiple individuals, you’ll be pleased to know that each person does not need their own personal copy. Two primary locations are recognized by Word, and each location can be used for a specific purpose, such as sharing Building Blocks in a single template with a workgroup. The following list describes each location:

- **Document Building Blocks folder** Used for personal Building Blocks and available to all documents. Depending on your operating system, the location of the Document Building Blocks folder is one of the following locations:
  - Windows Vista: C:\Users\user name\AppData\Roaming\Microsoft\Document Building Blocks\1033
Window XP: C: \Documents and Settings\user name\Application Data\Microsoft\Document Building Blocks\1033

Note
The numbered folder is specific to your language version of Word. For example, 1033 is an English language folder.

- **Word Startup folder** Used for company or workgroup Building Blocks. Templates placed in the Word Startup folder automatically load as a global template when Word starts, and the Building Blocks are available to all documents. The location of the Word Startup folder can be determined—or modified and pointed to in a shared network location—in Word Options at the bottom of the Advanced area by clicking the File Locations button. The location of the Word Startup folder can also be set during an administrative installation by using the Office Customization Tool (OCT) found in the Office Resource Kit 2007.

Note
If Building Blocks are specific to a certain type of document, then they should be placed in a document template instead of the Document Building Blocks or Word Startup folder.

After the template is placed in the respective folder, you need to exit and restart Word for the templates to load and make the Building Blocks available. If you prefer to use the Building Blocks immediately, then you can manually load the template as a global template as described in Chapter 4 in the section titled “Working with Global Templates.”

Note
If you add a number of custom Building Blocks to the Building Blocks template, remember to back up the template and store your backup copy in a separate location. Like the Normal.dotm template, the Building Blocks.dotx template could potentially become corrupt and you could lose your custom Building Blocks.

**Modifying Building Block Properties**
You can modify the properties of a Building Block—including changing the Save In template—by changing the information in the Modify Building Block dialog box, which
looks very similar to the Create New Building Block dialog box (shown earlier in Figure 8-4). To modify Building Block properties, access the Modify Building Block dialog box by taking either of the following actions:

- Right-click a gallery item and choose Edit Properties.
- Click Quick Parts on the Insert tab, click Building Blocks Organizer, select the name of the Building Block in the organizer list, and click the Edit Properties button.

After you open the Modify Building Block dialog box, make any desired changes and click OK to close the dialog box. A message box displays asking whether you want to redefine the Building Block entry as shown in Figure 8-5. If you click Yes, the changes are effective immediately.

![Figure 8-5](image)

**Figure 8-5** When you modify a Building Block entry, you are asked to confirm your modifications.

You can also redefine a Building Block, such as changing the content or formatting. Simply make your modifications and select the content. On the Insert tab, click Quick Parts, and then click Save Selection To Quick Parts Gallery, or press Alt+F3. In the Create New Building Block dialog box, type the same name as the Building Block that you want to redefine and make any other necessary changes, such as changing the gallery or category. When you click OK, you are prompted with a message asking whether you want to redefine your entry shown previously in Figure 8-5.

**Tip**

If you download Building Blocks from Microsoft Office Online, a template containing the Building Blocks is placed in your Document Building Blocks folder. It’s recommended that you move the downloaded Building Blocks to Building Blocks.dotx by editing the properties and changing the Save In location. Otherwise, several templates will load the first time you access a Building Block gallery or the Building Blocks Organizer, and you might see an increase in the initial delay. After the Building Blocks are moved, you might want to periodically delete the downloaded templates from the Document Building Blocks folder because they no longer serve a useful purpose. The location of the Document Building Blocks folder can be found in the Inside Out tip titled “Sharing Custom Building Blocks” earlier in this chapter.
Deleting Building Blocks

To delete content created by inserting a Building Block, simply delete the content as you would any other content. To delete a Building Block entry, select the Building Block in the Building Blocks Organizer and then click Delete. A message box displays that asks you to confirm the deletion. If you are sure, click Yes. As with new Building Blocks and modifications, you are prompted to save changes to the template accordingly, so you have one last chance to change your mind before permanently deleting a Building Block from a template.

INSIDE OUT

Using Custom galleries and the AutoText gallery

When creating or modifying a Building Block, you can select a Custom gallery or the AutoText gallery for your entries; however, by default, they only display in the Building Blocks Organizer. These galleries can be added to your Quick Access Toolbar for quick insertion by using the following steps.

1. Right-click the Quick Access Toolbar and then click Customize Quick Access Toolbar.
2. In the Choose Commands From list, select Commands Not In The Ribbon.
3. Locate AutoText or Custom Gallery Name, select the AutoText gallery or your desired custom gallery, and then click Add to add it to your Quick Access Toolbar.
4. Click OK to accept your changes and close Word Options.

Custom galleries can also be added to the Ribbon; however, doing so requires some XML knowledge, and this capability isn’t found within the Word application. For more information on customizing the Quick Access Toolbar and the Ribbon, see Appendix B, “Customizing Word and Enhancing Accessibility.”

Maximizing AutoCorrect

AutoCorrect is a terrific Word feature that corrects your errors—almost before you know you’ve made them. AutoCorrect comes with a library of more than one thousand different items that is shared across the 2007 Microsoft Office applications, and you can train it to learn new corrections as you work. For example, if you type your when you mean to type your, AutoCorrect automatically reverses the characters in words that it recognizes without any further action from you. You can also use the AutoCorrect functionality as a shorthand method to quickly insert common text and phrases.

AutoCorrect options can be found in Word Options in the Proofing section by clicking the AutoCorrect Options button or by pressing Alt+T+A. The AutoCorrect tab of the AutoCorrect dialog box is shown in Figure 8-6, and Table 8-1 contains a description of the
All AutoCorrect options are turned on by default, so you should turn off any unwanted options to prevent the correction from occurring while you work.

![AutoCorrect Options dialog box](image)

**Figure 8-6** Use the AutoCorrect Options dialog box to specify which items you want corrected automatically.

**Table 8-1 Setting Autocorrect Options**

<table>
<thead>
<tr>
<th>AutoCorrect Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show AutoCorrect Options Buttons</td>
<td>Displays an AutoCorrect Options button when a change is automatically made in your document</td>
</tr>
<tr>
<td>Correct Two Initial Capitals</td>
<td>Converts the second uppercase character to lowercase</td>
</tr>
<tr>
<td>Capitalize First Letter Of Sentences</td>
<td>Capitalizes the first letter of the first word in a new sentence; also applies to the first letter you type after pressing Enter</td>
</tr>
<tr>
<td>Capitalize First Letter Of Table Cells</td>
<td>Capitalizes the first letter of the first word entered in the cell of a table</td>
</tr>
<tr>
<td>Capitalize Names Of Days</td>
<td>Capitalizes the first letter of days of the week</td>
</tr>
<tr>
<td>Correct Accidental Usage Of cAPS LOCK Key</td>
<td>Catches the accidental pressing of the Caps Lock key, releases it, and toggles the case of typed characters</td>
</tr>
<tr>
<td>Replace Text As You Type</td>
<td>Enables AutoCorrect to make changes to text as you type; if you disable this option then common misspelled words will not be automatically corrected</td>
</tr>
<tr>
<td>AutoCorrect Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Replace and With text boxes</td>
<td>Enables you to add your own AutoCorrect entries to the AutoCorrect library</td>
</tr>
<tr>
<td>Automatically Use Suggestions From The Spelling Checker</td>
<td>Automatically corrects misspelled words that are similar to words in the main dictionary used by Spell Check</td>
</tr>
<tr>
<td>Exceptions</td>
<td>Enables you to specify which items not to correct automatically; for more information, see the section titled “Entering Exceptions” later in this section</td>
</tr>
</tbody>
</table>

**Controlling AutoCorrect While Working in Your Document**

When the AutoCorrect utility makes a change in your document, an AutoCorrect Options button provides you with options for controlling the change if it is unwanted. To view the AutoCorrect Options button, position the mouse pointer over the change that was made. A blue line displays below the change, and the AutoCorrect Options button appears as shown in the following figure. If you see only the blue line, place your mouse pointer below the change on the blue line.

Click the AutoCorrect Options button, and then click the Undo or Change option to revert to the previously typed data in the single instance only (you can also press Ctrl+Z or Undo to obtain the same result). Use the Stop option to always prevent the change, or click Control AutoCorrect Options to display the AutoCorrect dialog box. Note that the text of the Undo and Stop options varies depending on the correction made. Variations of some of the Undo or Change and Stop options that you might encounter are shown in the following figure.

**Adding AutoCorrect Entries**

You can add new AutoCorrect entries by using a few different methods. If you find a misspelled word that is not automatically corrected and Word provides a list of sugges-
tions for the spelling error, you can easily add the misspelled word as an AutoCorrect entry at the same time that you correct the misspelled word in your document. If you are using the Check Spelling As You Type feature, then after you right-click the misspelled word to view suggestions, use the AutoCorrect menu and select the correct word to both add the entry to AutoCorrect and correct the spelling error in your document. If you are using the Spelling And Grammar dialog box, then select the correct suggestion on the Suggestion list and then click the AutoCorrect button that displays for spelling errors.

**Note**
AutoCorrect entries are case sensitive. For example, if your misspelled word starts with a capital letter, then the only time that AutoCorrect makes the correction is when it is typed in the exact same case as the AutoCorrect entry. To avoid this situation, use the AutoCorrect dialog box to add your entry as described in the following section.

You can also use the AutoCorrect dialog box to add new AutoCorrect entries. This method is useful if you have several entries to add, if you need to control the case of the AutoCorrect entry as described in the previous cautionary note, or if you want to use AutoCorrect to replace lengthy words or phrases. For example, if you include your organization’s detailed legal copyright statement on everything you print, you can create an AutoCorrect entry that inserts the entire mission statement when you type the letters _lgco._

**Note**
AutoCorrect entries are stored in .acl files and are language specific. If you work with multiple languages, verify your current proofing language before creating new AutoCorrect entries.

Additionally, AutoCorrect entries cannot exceed 255 characters. If your AutoCorrect replacement text exceeds the limitation, then create a Building Block instead.

To add new entries by using the AutoCorrect dialog box, use the following steps:

1. Click the Microsoft Office Button, click Word Options, navigate to the Proofing area, and then click the AutoCorrect Options button or press Alt+T+A.

2. In the Replace text box, type the characters that you want to use for your AutoCorrect entry. To make the entry case insensitive, use lowercase letters.
CAUTION!

Do not use characters that form a word or acronym that you need to use in your Word documents or other 2007 Microsoft Office applications, for they will always be corrected automatically.

Furthermore, playing tricks on your co-workers, such as changing 2007 to 2006, is strongly discouraged.

3. In the With text box, type the word or phrase that you want replaced automatically in your document as you type. Include any desired capitalization and punctuation.

4. Click Add. Word then adds the new AutoCorrect entry to the list.

Tip

To use the Formatted Text option, you need to select the formatted data in a document and then display the AutoCorrect dialog box. However, depending on the formatting, you might want to create a Building Block instead.

Formatted AutoCorrect entries (rich text entries) are not shared with other 2007 Microsoft Office applications and are stored in your Normal template.

Replacing and Deleting AutoCorrect Entries

You can edit AutoCorrect entries in the AutoCorrect dialog box by modifying the text in the With text box. The button beneath the list then changes from Add to Replace. When you use the Replace button, Word displays a message box asking you to confirm the action.

You can delete entries in a similar way. Display the AutoCorrect dialog box and, on the AutoCorrect tab, scroll or type the first few characters of the entry in the Replace text box to quickly navigate to the entry. Select the desired entry and click the Delete button. Unlike replacing entries, Word does not display a confirmation for deleting AutoCorrect entries. If the deletion is accidental, you can immediately click the Add button to add the entry back.

Entering Exceptions

Although AutoCorrect is extremely helpful, there are times when you might not want it interfering with what you’re trying to do. For example, you might be typing a document full of chemical compounds or creating a list of access codes for the new server. You don’t want AutoCorrect to get in there and change the capitalization while you type.
In this case, you have two options: You can disable AutoCorrect while you’re working on the document, or you can create an exception to specify what you don’t want AutoCorrect to change. To add an exception, display the AutoCorrect dialog box, click the Exception button, and add your exception to the respective tab in the AutoCorrect Exceptions dialog box, as shown in Figure 8-7.

Figure 8-7 You can use exceptions to prevent AutoCorrect from making specific corrections.

The Automatically Add Words To List option in the AutoCorrect Exceptions dialog box enables you to add exceptions as you work by clicking Undo or pressing Ctrl+Z immediately after an undesired correction is made. Note that this only applies to case changes and not to the Replace Text As You Type option.

To enter AutoCorrect exceptions, click Exceptions on the AutoCorrect tab in the AutoCorrect dialog box, and you can add the following three types of exceptions:

- **First Letter** This form of capitalization controls the words immediately following abbreviations. (For example, you might have a phrase such as after the merging of Lake Ltd. and Smith Co., in which the word and should not be capitalized.)

- **Initial CAPS** Enables you to enter words and phrases with unusual capitalization that you don’t want changed. This might include company names or abbreviations or terms peculiar to your business or industry.

- **Other Corrections** Enables you to add additional items that you don’t want AutoCorrect to change. This might include names, locations, unusual spellings, and phrases that reflect terminology particular to your work.

**Linear Format: Math AutoCorrect**

Linear Format is used for creating equations by using a keyboard-based syntax notation, similar to TeX, that converts strings to symbols or groups of characters to Professional Format. For example, a caret (^) converts the next typed character to superscript and an underscore (_) converts the next typed character to subscript. The advantage to Linear Format is that you can create an equation by using notation such as
\((a^2+b^2) + (c^2+d^2)\), and it is converted to Professional Format while you type, as shown in the following image.

\[
\frac{a^2 + b^2}{c^2 + d^2}
\]

The newest member of the AutoCorrect family, Math AutoCorrect is very similar to AutoCorrect but is used for Linear Format. For example, Math AutoCorrect changes \(\pi\) to \(\pi\) or \(\int\) to \(\int\).

**Note**
Math AutoCorrect entries are case sensitive. An entry such as \(\Sigma\) changes to \(\Sigma\) (the uppercase Greek character) and \(\sigma\) changes to \(\sigma\) (the lowercase Greek character).

Math AutoCorrect options can be found in the AutoCorrect dialog box (Alt+T+A) as shown in Figure 8-8.

**Figure 8-8** Math AutoCorrect enables the use of Liner Format to create equations.
Note
The Recognized Functions button provides a list of expressions that are not automatically italicized when creating equations. You can add additional expressions to the list.

If you want to use Math AutoCorrect anywhere in your document, select the Use Math AutoCorrect Rules Outside Of Math Regions option. Otherwise, you can only use Math AutoCorrect in an Equation Content Control by inserting a new equation from the Equation gallery on the Insert tab or by pressing Alt+=.

Note
The Equation gallery and the ability to insert new equations are disabled if using Word in Compatibility Mode; however, Math AutoCorrect can still be used.

To create new Math AutoCorrect entries, first select the desired symbol or group of symbols in a document and display the AutoCorrect dialog box (Alt+T+A). On the Math AutoCorrect tab, type your replace characters in the Replace text box. Your replace characters do not need to start with a backslash (\), but this syntax is recommended to maintain consistency.

Note
If you have standard equations, consider turning them into Building Blocks and associate them with the Equations gallery to ease insertion.

INSIDE OUT  Call attention to your equations
You can add emphasis to an equation by adding a rectangle (\rect ) around the equation so it stands out. For example, create a new equation (Alt+=) and type \rect (\quadratic ) (note the spaces). Your equation should look like the following image:

\[
  x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a}
\]
Note that spaces are important because they trigger Math AutoCorrect so that the equation is converted as you type. In the example equation, once you type the space after `\rect`, you see a small rectangle. The space after `(\quadratic)` converts to a quadratic formula. After you type the closing parentheses and the space, the rectangle is placed around the equation.

Math AutoCorrect entries can be modified and deleted by using the same steps provided in the section titled, “Replacing and Deleting AutoCorrect Entries” earlier in this chapter.

If you’re unfamiliar with the new Equation Builder in Word 2007, refer to Chapter 6, “Mastering Document Fundamentals,” for more information.

Using AutoFormat Effectively

If you granted three wishes to Word users, at the top of the list would be improved control over automatic features. Until you understand what’s going on behind the scenes with the various tools, you often don’t know where to go when Word begins indenting lists that you don’t want indented, adding numbers that you don’t want added, or adding formatting, symbols, or lines that span the entire width of the page against your will. Such is the downside of automated functionality.

But the good news is that you have control over these automatic features. You can turn each feature on and off and control the items you want Word to change on the fly. This section takes a look at another automatic feature, AutoFormat As You Type. A description of each option is provided, along with instructions on how to implement the options so that you can obtain the most effective use and control over this automatic functionality.

Note

Like AutoCorrect, when Word automatically makes a formatting change, an AutoCorrect Options button displays and provides the Undo and Stop options. If the AutoCorrect Options button does not disappear, press Esc to dismiss it.

The AutoFormat As You Type options can also be found in the AutoCorrect dialog box (Alt+T+A). Table 8-2 provides a description of each option and instructions on how to utilize the option in a document.
### Table 8-2 AutoFormat As You Type Options

<table>
<thead>
<tr>
<th>AutoFormat Option</th>
<th>Description and Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Straight Quotes” With “Smart Quotes”</td>
<td>Converts typed quotes and apostrophes to smart, or <em>curly</em> quotes</td>
</tr>
<tr>
<td>Fractions (1/2) With Fraction Character (½)</td>
<td>Replaces full-sized typed fractions, such as 1/2, with the fraction symbol; only works for common fractions such as ¼, ½, and ¾</td>
</tr>
<tr>
<td><em>Bold</em> And <em>Italic</em> With Real Formatting</td>
<td>A word surrounded by asterisks or underscores is formatted as bold and italic, respectively; the asterisks and underscores are removed</td>
</tr>
<tr>
<td>Internet And Network Paths With Hyperlinks</td>
<td>Automatically converts recognized URLs, network paths, and e-mail addresses to hyperlinks</td>
</tr>
<tr>
<td>Ordinals (1st) With Superscript</td>
<td>Inserts ordinals (such as 1⁰, 2²d, 3³d) when you type full-sized ordinals</td>
</tr>
<tr>
<td>Hyphens (--) With Dash (—)</td>
<td>Replaces two consecutive hyphens (--) with an em dash (—); for an en dash (--), type a space before and after two consecutive hyphens ( -- )</td>
</tr>
<tr>
<td>Automatic Bulleted Lists</td>
<td>An asterisk (*) followed by a tab at the beginning of a line is converted to a bulleted list</td>
</tr>
<tr>
<td>Border Lines</td>
<td>Three consecutive symbols, such as ~,#,*,-,= at the beginning of a line are converted to borders</td>
</tr>
<tr>
<td>Built-In Heading Styles</td>
<td>Automatically formats short paragraphs (without a period) with Heading styles after pressing Enter twice; a short paragraph at the beginning of the line is formatted with Heading 1, a tab preceding a short paragraph is formatted with Heading 2, two tabs followed by a short paragraph is formatted with Heading 3, and so on</td>
</tr>
<tr>
<td>Automatic Numbered Lists</td>
<td>A number followed by a period and a tab or space at the beginning of a line is converted to a numbered list; numbers not followed by a period, along with a tab or at least two spaces, can be converted to a numbered list after pressing Enter</td>
</tr>
<tr>
<td>Tables</td>
<td>A series of vertical bars (</td>
</tr>
<tr>
<td>Format Beginning Of List Item Like The One Before It</td>
<td>Applies identical formatting to the second and consecutive items in a list; formatting of last character, even a space, determines format</td>
</tr>
<tr>
<td>Set Left And First Indent With Tabs And Backspace</td>
<td>Pressing Tab at the beginning of a previously typed paragraph formats the paragraph with a First Line Indent; pressing Backspace after Tab formats the paragraph with a Left Indent</td>
</tr>
<tr>
<td>Define Styles Based On Your Formatting</td>
<td>Applies built-in styles that match paragraph formatting; recommended that this option be left turned off because it doesn’t always function and, when it does, you have no control over which style is applied</td>
</tr>
</tbody>
</table>
Where is the AutoFormat command?
The AutoFormat command enables you to apply many of the AutoFormat As You Type options to previously typed documents, along with a few others. Although it does not display in the Ribbon by default, its options (also found in the AutoCorrect dialog box) and command are still available. To add the AutoFormat command to your Quick Access Toolbar, right-click the Quick Access Toolbar and then click Customize Quick Access Toolbar. Display the commands for Commands Not In The Ribbon, select AutoFormat, and then click Add to add it to your Quick Access Toolbar.

Getting ‘Smarter’ with Smart Tags

The new release of Word continues to support Smart Tags. Smart Tags deliver what their name suggests—tagged data includes additional actions that make you “smarter” by giving you wider access to the data in your applications. A Smart Tag displays with a purple dotted underline below the tagged data. When you hover your mouse over the data, a Smart Tag Actions button appears as shown in the following figure.

A Smart Tag is meant to be an intuitive link, an easy connection to more information about the tagged item. For example, suppose that you’re writing a report that summarizes new research that your department has recently completed. When you type the list of contributing writers, you see the name of a person you recognize, but you can’t recall her department. In theory, if the information about the employee has been entered, you should be able to position the pointer over the employee’s name and view additional information about her such as her name, phone, office status (in a meeting or out of office), online status, and e-mail address as well as the ability to create a new e-mail message addressed to her, call her on the telephone, or send an Instant Message. If you like this theory, then you’ll like Smart Tags.

Using Smart Tags

If you are unfamiliar with how Smart Tags work in Word (or Microsoft Office) documents, then the best way to understand their capability is to see them in action by following these steps:

1. Display the AutoCorrect dialog box (Alt+T+A).

2. Click the Smart Tags tab, and select the Label Text With Smart Tags option as shown in Figure 8-9.
Figure 8-9 Turn Smart Tags on and off and select the options you want in the AutoCorrect dialog box on the Smart Tags tab.

Note
Smart Tags are turned off by default in Word 2007.

3. Select Financial Symbol, click OK to accept the changes, and close the dialog box.

4. Create a new document and type your favorite stock symbol, such as MSFT. Press the spacebar, and you should see a purple dotted underline appear below the stock symbol.

5. Click the Smart Tag Actions button (hover your mouse over the stock symbol if you do not see it).

6. Click Stock Quote On MSN Money Central.
   Word opens your default browser (such as Internet Explorer), takes you to MSN Money Central, and displays a stock quote.

The actions that appear when you click the Smart Tag action button vary depending on the type of data that is tagged. Figure 8-10 contains a sample of several options that you might encounter.
Turning Off Smart Tags

If you don’t want to use Smart Tags, simply display the Smart Tags tab in the AutoCorrect dialog box (as shown in Figure 8-9), clear the Label Text With Smart Tags check box, and then click OK. Smart Tags are now disabled.

Rechecking Your Document

After you make a change to Smart Tags, you should recheck your document by clicking the Recheck Document button on the Smart Tags tab in the AutoCorrect dialog box. Word warns you that changes made by the grammar checker might be reversed as you recheck Smart Tags. If you want to continue, click Yes; otherwise, click No.

Obtaining Additional Smart Tags

New Smart Tags are created by developers, and you can obtain additional Smart Tags from the Microsoft Web site. Start by establishing your Internet connection, and then display the Smart Tags tab in the AutoCorrect dialog box. When you click More Smart Tags, Word starts your default browser (such as Internet Explorer) and takes you to Microsoft Office Marketplace to find more information. Follow the prompts on the screen to navigate to and download Smart Tags that you can use to extend the functionality of Word.
Understanding Smart Tags

Smart Tags do more, reach further, and are more flexible than ever before. Those who develop Smart Tags find that they have more control over the Smart Tags they create and are able to develop and deploy Smart Tags easily. Support for XML throughout the 2007 Microsoft Office system adds an extra boost by enabling developers to use XML to extend the Microsoft Office Smart Tag List Tool (MOSTL), the Smart Tag recognizer and action handler, without going back into the code.

How does your organization use Smart Tags? In terms of corporate possibilities, companies that want their employees to be able to link to critical resources inside the company use Smart Tags. Smart Tags are ideal for documents that must be processed, such as invoices or expense reports. For example, suppose that a user enters a tracking number in a document. A Smart Tag recognizes the item and, when the user clicks the Smart Tag, the options offer the user the ability to view—right from the current document—that particular order in the inventory system. Another option might fill in the details from that invoice automatically, thereby saving the user keystrokes, time, and error checking. The Smart Tag possibilities are endless.

What’s Next?

This chapter took a look at how you can effectively implement Building Blocks and other text tools to help turn repetitious tasks into a few clicks of the mouse or strokes on the keyboard. The next chapter takes a look at proofing, research, and reference tools. Learn more about the new contextual spell check feature and improved automatic word count, along with how to translate text, look up definitions in a dictionary, and use an encyclopedia—all without leaving Word.